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PCB Design System

Ein Schnelleinstieg in CIS
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FlowCAD Confidential

Vorbemerkung
• Die vorliegende Dokumentation gilt dem Erstanwender der OrCAD CIS 

Option. Sie soll weder als Trainingshandbuch noch als komplette 
Bedienanleitung verstanden werden. 

• Basis für die Arbeit mit CIS sind Capture Grundkenntnisse, da CIS eine 
Capture Option und kein eigenständiges Tool ist. 

• Auf Grund der notwendigen Kürze und Kompaktheit  dieser 
Dokumentation kann natürlich nicht auf alle vorhandenen Befehle und 
deren Feinheiten eingegangen werden. Hierzu sei auf die umfangreiche 
Dokumentation innerhalb der Installation verwiesen, die sowohl als 
HTML wie auch als PDF Dokumentation vorliegt.

• An Hand eines einfachen Schaltplanes sollen die wichtigsten Schritte 
innerhalb des Designablaufes dargestellt und erläutert werden, die es 
dem Erstanwender dieses Systems erlauben, mit einem Minimalaufwand 
an Einarbeitungszeit die ersten eigenen Aufgaben selbständig zu 
bewältigen.

• Nach einigen Vorabinformationen zur Software beginnt die Anleitung. 
• Sämtliche Befehle und Funktionen, die in dieser Anleitung verwendet 

werden, sind mit der DEMO Version durchführbar.
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FlowCAD Confidential

Systemvoraussetzung (Vollversion 16.6)

Betriebssysteme: Windows 2008 Server (32- und 64-bit)
Windows XP Professional – SP3 oder höher (32-bit)
Windows Vista (32- und 64-bit) außer Home Basic
Windows 7 (32- und 64-bit) außer Home Basic

Hardware: Intel IA-32 kompatible (inklusive Intel P4 EMT und AMD OpteronTM); 1.2 
GHz Minimum; 2.4 GHz oder mehr ist zu empfehlen. 
Hinweis: Cadence SPB Produkte unterstützen IPF Chip nicht.
DVD-ROM Laufwerk
Netzwerkkarte (falls MAC/Ethernet Lizenzierung)
Maus mit drei Tasten 

Minimum: 1GB RAM
10GB Festplatte
Virtueller Speicher sollte mindestens doppelt groß wie RAM sein
1024x768 Auflösung mit 64,000 Farben

Empfohlen: 4GB RAM
50GB Festplatte
Virtueller Speicher sollte mindestens doppelt groß wie RAM sein

1280x1024 Farbe Qualität 32 Bit Grafik
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FlowCAD Confidential

Eigenschaften der Vollversion

• CIS steht für Component Information System

• CIS verlinkt eine frei definierbare Daten Struktur mit Capture

• Verwaltet alle Bauteil Informationen

• Verwaltet Varianten

• Erzeugt Stücklisten anhand von Templates

• Verwaltet Dokumente wie Datenblätter und Applications Beschreibungen

• CIS steht für Component Information System

• CIS verlinkt eine frei definierbare Daten Struktur mit Capture

• Verwaltet alle Bauteil Informationen

• Verwaltet Varianten

• Erzeugt Stücklisten anhand von Templates

• Verwaltet Dokumente wie Datenblätter und Applications Beschreibungen

Einschränkungen der Demo-Version
• In der Demo Version ist die CIS Bauteil Datenbank auf 1000 Bauteile beschränkt.

• Dieser Schnellstart enthält eine Beispiel Datenbank im Access und Excel Format.

• Wenn möglich nutzen sie die Access Version, sie bietet mehr Funktionalität.

• In der Demo Version ist die CIS Bauteil Datenbank auf 1000 Bauteile beschränkt.

• Dieser Schnellstart enthält eine Beispiel Datenbank im Access und Excel Format.

• Wenn möglich nutzen sie die Access Version, sie bietet mehr Funktionalität.
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Installation und Einstellungen
• Die Installation der Software entnehmen Sie bitte dem 

Capture Schnellstart. Sollte Capture bereits installiert 
sein, ist keine zusätzliche Installation notwendig.

• Sie brauchen lediglich den CIS_Schnellstart_V1_1.exe 
ausführen. Der Installer legt die Datenbank in ihrem 
System ab und macht alle Einstellungen 

• Dieser Installer ist kein zertifizierter Installer. Daher 
kann es sein, das Ihr Virenscanner die Ausführung 
blockiert oder Sie die Ausführung bestätigen müssen. 

• Die Installation der Software entnehmen Sie bitte dem 
Capture Schnellstart. Sollte Capture bereits installiert 
sein, ist keine zusätzliche Installation notwendig.

• Sie brauchen lediglich den CIS_Schnellstart_V1_1.exe 
ausführen. Der Installer legt die Datenbank in ihrem 
System ab und macht alle Einstellungen 

• Dieser Installer ist kein zertifizierter Installer. Daher 
kann es sein, das Ihr Virenscanner die Ausführung 
blockiert oder Sie die Ausführung bestätigen müssen. 
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Übungsbeispiel

FlowCAD Confidential

• Wir nutzen ein kleines vorbereitetes Beispiel.

• Im CIS Schnellstart werden die Capture Funktionen nicht erklärt. 
Gehen Sie bitte vorher den Capture Schnellstart durch.

• Anhand eines kleinen Beispiels platzieren Sie Bauteile über die CIS 
Oberfläche, definieren Varianten und erstellen Stücklisten.

• Öffnen sie dazu das Projekt FC_CIS.opj

• Gehen Sie im Capture nach Options > CIS Configuration > Browse. 
Im Schnellstart finden sie 2 DBC File. Wählen sie den, zu ihrem 
ODBC Treiber passenden aus.

• Das nachfolgende Bild zeigt den zu erstellenden Schaltplan.
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Übungsbeispiel fertig

FlowCAD Confidential
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Übung - Bauteilsuche über Datenbank Tabellen - 1

FlowCAD Confidential

• Öffnen Sie die Schaltplan Seite Clock. Sie 
enthält einige vorbereitete Elemente. 
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Übung - Bauteilsuche über Datenbank Tabellen - 2

Sie starten nun den CIS Explorer um neue Bauteile zu 
platzieren. Dazu stehen 2 Methoden zur Verfügung:

• Place > Database Part... über das Pull-Down Menü

• Z (Tastatur)

In der oberen linken 

Ecke finden Sie Ihre 

Datenbank Tabellen. 

FlowCAD Confidential
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Übung - Bauteilsuche über Datenbank Tabellen - 3

Öffnen Sie die Tabelle 99-Misc und selektieren den Ordner Crystal. Im unteren Fenster erscheint ein 
Datensatz. Selektieren Sie diesen. Eine komplette Vorschau des Bauteils wird angezeigt. Die 
Anordnung der einzelnen Fenster können Sie individuell gestaltet.

Selektieren Sie den unterstrichenen Eintrag unter Datasheet. Dies ist ein Link zum Datenblatt, das 
sich automatisch öffnet, wenn sie Zugang zum Internet haben.

Mit einem Doppelklick auf den grün hinterlegten Datensatz wird das entsprechende Bauteil auf Ihrer 
Schaltplanseite platziert.

Drücken Sie Z, der CIS Explorer tritt in den Vordergrund. Öffnen Sie die Tabelle 1-Capacitor und 
selektieren X7R. Im unteren Fenster erscheinen mehrere Datensätze . Mit einem Doppelklick auf die 
Spaltenüberschrift Value werden die Bauteile nach 

FlowCAD Confidential

Werten sortiert. Wählen Sie einen 4.7p
Kondensator im 0603 Gehäuse. Sobald der 
entsprechende Datensatz selektiert wurde, wird 
wieder die Vorschau angezeigt. Unter anderem 
finden Sie 2 relational verknüpfte Datensätze mit 
Herstellerinformationen. 

In der Spalte Schematic Part können Sie 
auswählen, mit welcher graphischen Darstellung 
das Bauteil platziert wird.

Über einen Doppelklick auf den ausgewählten 
Kondensator, wird auch dieser platziert
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Übung - Bauteilsuche über Suchbegriffe - 3

Drücken Sie Z um den CIS Explorer wieder in den Vordergrund zu 
holen. Das linke obere Fenster hat 2 Tabs. Drücken Sie auf den Tab 
Query. Hier besteht die Möglichkeit Bauteile über deren Werte zu 
suchen. Geben Sie die unten gezeigten Suchbegriffe ein und 
drücken Enter. Als Suchergebnis wird ein Datensatz angezeigt.

Bei der Eingabe der Daten ist ihnen vielleicht aufgefallen, das Sie im 
Feld Compare nicht nur mit = arbeiten können, sondern auch mit <, 
> usw.

Testen Sie verschiedene Funktionen und platzieren alle benötigten 
Bauteile.

FlowCAD Confidential

Am Ende sollte Ihr Schaltplan, wie oben 
gezeigt, aussehen. Schließen Sie den CIS 
Explorer und die Schaltplanseite. Das 
Projekt kann für die nächste Übung 
geöffnet bleiben.
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Sperren von Bauteilen

• Wenn Sie im CIS Explorer auf die Tabelle 1-Capacitor
gehen und den Typ ELEC selektieren, stellen Sie fest, 
dass die Bauteile den Part_Status obsolete haben und 
es ist daher nicht mehr erlaubt, diese Bauteile in 
Projekten zu platzieren. 

• In der Vollversion gibt es die Möglichkeit, Property 
Werten Farben und Aktion zuzuweisen. Damit kann ein 
obsolete Bauteil zum Beispiel nicht mehr platziert 
werden oder ein Vorzugsteil ist grün unterlegt.

FlowCAD Confidential
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Übung: Bauteil in CIS DB eintragen

Abschließend öffnen Sie die Access DB oder das Excel 
Sheet der FlowCAD Library, je nach dem, was Sie bei der 
Installation ausgewählt haben. 

Fügen Sie einen neuen Datensatz am Beispiel der 
vorhandenen Datensätze hinzu. Die Datenbank enthält im 
Feld Schematic Part den OLB und den Symbolnamen und 
unter Jedec_Type den Footprint. Bitte benutzen sie nur 
existierende Symbole und Footprints.

Danach steht das Bauteil im CIS Explorer zur Verfügung.

FlowCAD Confidential
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Übung Derive Part

Öffnen Sie den CIS Explorer und selektieren 
ein beliebiges Bauteil aus der DB.

Selektieren Sie Edit > Derive New Database 
Part in der Menübar.

Ändern Sie einige Werte, suchen nach einem 
anderen Footprint, usw. Drücken Sie Place 
Part.

Wählen Sie Ja. 

Das Bauteil wird in der CIS DB gespeichert 
und hängt gleichzeitig am Kursor, um es im 
Schaltplan zu platzieren. Es wird mit einer 
temporären Part Nummer abgelegt.

Schließen Sie den CIS Explorer und 
wechseln wieder auf die Seite 
05_MHC/Clock.

FlowCAD Confidential
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Übung: Stückliste (BOM)

Selektieren Sie den DSN File und 
selektieren Reports > CIS Bill of
Materials > Standard.

Geben Sie oben einen Template Namen 
ein. Anschließend können Sie alle 
Properties, die Sie in der BOM haben 
wollen auf die rechte Seite schieben und 
mit den beiden Pfeil Tasten sortieren.

Wählen Sie alle weiteren Einstellungen, 
wie oben gezeigt und drücken OK. 

Es öffnet sich ein Excel Sheet mit Ihrer 
Stückliste. Das Template wird in Ihrer DE 
CIS Konfigurationsdatei abgelegt. Sie 
können mehrere Templates definieren 
und später auswählen.

FlowCAD Confidential
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Design Varianten

• Mit dem Part Manager verwalten Sie Ihre 
Bauteile, führen Datenbank Updates durch 
oder generieren Varianten.

• Das Erstellen vor Varianten versteht man 
am besten am Beispiel. 

FlowCAD Confidential
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Übung – Varianten - Groups

Selektieren Sie den DSN File und öffnen den Part Manager 
über RMB > Part Manager oder Tools > Part Manager.

Um Varianten zu beschreiben, müssen Sie ihr Design in 
Gruppen aufteilen. Es ist sinnvoll alle Bauteile einer 
Funktionsgruppe in jeweils eine Gruppe der 
Variantenbeschreibung abzulegen. Funktionsgruppen, die 
keine Bestückungsvarianten haben, verbleiben in der 
Common Group.

Selektieren Sie Groups > RMB > New Group. Erstellen 
Sie die Gruppe Clock.

Wiederholen Sie diesen Vorgang und 

generieren die Gruppen PCIE

FlowCAD Confidential



FlowCAD

w
w

w
.F

lo
w

C
A

D
.d

e

18

Übung – Varianten - Subgroups

Als nächstes definieren Sie die 
Subgroups. Diese enthalten die 
unterschiedlichen 
Bestückungsvarianten der 
Gruppen. Selektieren Sie die 
Gruppe Clock > RMB > New 
Subgroup. Geben Sie 
HalfMounted ein. Wiederholen 
Sie diesen Vorgang, bis Sie das 
gezeigte Bild haben.

FlowCAD Confidential
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Übung – Variante - Bauteile zuweisen

Öffnen Sie die Seite Clock und selektieren 
Sie alle Bauteile. RMB > Add part to
Group, wählen Sie die Gruppe Clock > 
Add. 

Wiederholen sie diese Aktion mit der 2. 
Seite und schieben alle Kondensatoren, 
nicht den Stecker, in die Gruppe PCIE.

FlowCAD Confidential
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Übung Variante - Nicht bestückte Bauteile markieren

Gehen Sie in den Part Manager und selektieren 
eine Subgroups HalfMounted. Selektieren Sie 
einige Bauteile > RMB > Set Part as not present. 
Alle nicht bestückten 

Bauteile sind mit einem 

roten Kreuz markiert.

Widerholen sie diese 

Aktion in einer anderen

Subgroup.

FlowCAD Confidential
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Übung – Variante - Alternative Bestückung definieren

Gehen Sie in die Subgroup Alternate und selektieren ein Bauteil, vorzugsweise ein 
Widerstand oder Kondensator > RMB > Link Database Part. Der CIS Explorer öffnet 
sich. Nutzen Sie die Ihnen bekannten Funktionen um ein alternatives Bauteil 
auszuwählen. Achten Sie darauf, dass die Bauteile identische Symbole und Footprint
haben. Definieren Sie diverse Bauteile mit alternativer Bestückung.

Der CIS Explorer unterstützt Sie bei Ihrer Suche. Properties mit unterschiedlichem Inhalt 
sind rot markiert.

Link Database Part funktioniert auch, wenn Sie mehrere gleiche Bauteile im Part 
Manager selektieren. Alle Bauteile mit alternativer Bestückung sind mit einem grünen 
Haken markiert.

FlowCAD Confidential
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Übung - Varianten Stückliste definieren

Selektieren Sie BOM Variants > RMB > 
New BOM Variants und geben Sie den 
Namen BOM1 ein. Wiederholen Sie 
diesen Vorgang mit den Wert en BOM2 
und BOM3.

Ziehen Sie jeweils eine Subgroup pro 
Gruppe in die BOM. Abschließend muss 
die Common Group noch in die BOM 
übernommen werden. Sie enthält den 
Pcie Stecker, der keiner Gruppe 
zugewiesen wurde.

Das Resultat sollte wie rechts.

FlowCAD Confidential
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Übung - Varianten Schaltplan

Schließen Sie den Part Manager, gehen auf eine 
Schaltplan Seite mit Variantenbeschreibung und 
selektieren View > Variant View Mode. Selektieren Sie 
eine der Varianten. Nicht bestückte Bauteile werden grau 
mit dem Schriftzug DNI, Bauteile mit einer alternativen 
Bestückung werden grün dargestellt. Die Farben können 
Sie über Options > Preferences einstellen

Im Variant View Mode sind viele Funktionen ausgegraut. 
Stellen Sie diese Einstellung zurück auf Core, bevor Sie 
mit dem Design weiterarbeiten.

FlowCAD Confidential
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Übung - Varianten Report

Mit dem Variant Report können Sie Varianten Definitionen 
überprüfen. Öffnen Sie den Part Manager und selektieren 
Report > Variant Report. Setzen Sie die Einstellungen wie 
rechts gezeigt.

Selektieren Sie eine der 

Varianten > OK. 

Der Report wird erzeugt und 

dargestellt. Sie bekommen 

eine direkte Gegenüberstellung von Core Design und 
Variante.

FlowCAD Confidential
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Übung - Varianten Stückliste

Über Report > CIS Bill of Material > Standard öffnet sich das, ihnen 
bereits bekannte, BOM Menü.

Nutzen Sie ein existierendes Template und selektieren Sie eine der 
Varianten. Über der Liste mit den Varianten, finden Sie Variants „Not 
Stuffed“ Qty 0 Displayed. Mit einem Haken dort werden alle nicht 
bestückten Bauteile mit der Anzahl 0 in der Stückliste mit ausgegeben. 

Mit OK starten Sie die Stücklisten Ausgabe.

Die Varianten BOM wird angezeigt.

FlowCAD Confidential
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Vielen Dank

für Ihr Interesse!


